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Correlator Application User Guide

Peter Blum, 21 November 2016

1. Introduction

The Correlator application is a user application that facilitates stratigraphic correlation of
cores from multiple holes at a drill site, by depth shifting cores to construct a core
composite depth below sea floor (CCSF) depth scale, and splicing selected core intervals to
construct the most complete stratigraphy possible at a site, based on high-resolution core
logging data.

On the JOIDES Resolution (JR), where stratigraphic correlation has become a standard
operating procedure over the past two decades, additional stratigraphic correlation support
(SCORS) applications interact with the JRSO Laboratory Information Management System
(LIMS) and further facilitate the process for the user (Fig. 1-1):

e SCORS Downloader: Allows user to download core logging data from the LIMS
database, offering filters and features to make iterative downloading and appending
of data during the coring process more efficient.

e SCORS Uploader: Allows user to upload affine table (depth offsets for cores) and
splice interval tables to the expedition LIMS database. LIMS internal computations
create a CCSF depth scale that can be applied to any data in LIMS.

o SpliceFileFixer: Allows user to check if the splice intervals generated by an external
application, such as Correlator, are consistent with the core and section information
in the LIMS registry.

e LORE (LIMS online reports): Reports allow user to retrieve (A) Lists of existing
affine tables and splice interval tables, with links to uploaded user files; (B) detailed,
LIMS-computed affine and splice interval tables; (C) CCSF (alternate) depths for any
data set in the LIMS; and (C) data sets by selected splice.

These LIMS applications are described in a separate user guide because the Correlator
application does not directly interact with the LIMS and can be used with data generated
elsewhere, as long as some basic input file specifications are honored. Correlator output is
independent of the LIMS as well, however, affine tables and splice interval tables must
follow specifications to ensure they can be loaded to the LIMS.

The reasons for Correlator being decoupled from the LIMS infrastructure are both historical
and practical: the Correlator application began as the third-party "Splicer” program in the
early 1990ies; and other programs have been, and can be used as well for shifting and
splicing cores. Following the "Splicer" era of the Ocean Drilling Program (ODP; 1983-2003),
Correlator was further developed as a third party tool at the LDEO, as part of the Corewall
suite of software application. When that effort essentially ended ten years later, and JR user
change requests for Correlator persisted, a service agreement between the current main
supporter of Corewall (CSDCO, University of Minnesota) and the JRSO was eventually
established (August 2015). Under that agreement, a small team directs and implements
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user change requests, and ensures compatibility with the LIMS, with a modest annual
budget allocated at the JRSO for ongoing programming support. A first task set focusing on
the robust and accurate definition of splice intervals was completed in 2016. A second task
set focusing on enhanced depth shifting options will be completed in 2017.

Figure 1-1: Overview of SCORS tools and data flow and how they relate to the Correlator
application. Red shapes are LIMS applications extracting and/or loading data from/to the LIMS
database. Yellow shapes are data files.
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required “sandbox” is currently too costly. However, that part of the process is quick and
simply compared to learning the Correlator applications.

2. Process overview

Creating affine table and splice interval table files (the correlation files in short) is the
essence of the affine-based stratigraphic correlation process, and the primary task of the
stratigraphic correlation specialist (SCS) aboard the JR. Two sub-tasks must be completed in
sequence:

a) Depth shifting of cores from multiple holes in a way that optimizes correlation of
stratigraphic features across the holes.

b) Definition of splice intervals that result in the most complete stratigraphic
representation possible.
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Construction of the composite depth scale and the selection of splice intervals have a
significantly subjective aspect. Scientific parties usually place a large degree of confidence
into the shipboard SCS to accomplish these tasks to the satisfaction of the scientists, who
use the splice for integrated subsampling and postcruise analysis of the cores. The basic
rules, terminology and specifications provided here aim at providing a robust depth scale
and splice support structure while at the same time strengthening correlation specialists’
confidence in serving the science party and the science parties’ confidence in the methods
and the reliability of the results.

The affine-based correlation and splicing process by definition creates a stratigraphic
section from a selection of core intervals and therefore leaves non-splice intervals in most
cores from the holes participating in the CCSF depth scale. Stratigraphic features in the non-
splice intervals of adjacent holes do not have the exact same depth than corresponding
features in the splice at a cm-dm scale, even though they are at the same CCSF scale, because
cores are stretched and squeezed during recovery, or because the stratigraphic architecture
is not a perfect layer cake. Non-splice intervals can be mapped separately to the splice using
a general depth mapping process. This process is currently being examined and defined to
determine if [ODP should implement SCORS infrastructure in the future to support it.

Depth shifting of cores and the affine table

Stratigraphic correlation specialists define a core composite depth below seafloor (CCSF)
depth scale in the form of an affine table (example in Table 2-1; specifications in Appendix
1). Using different types of high-resolution data sets obtained from the cores recovered in
multiple adjacent holes, each core is shifted to optimize alignment of stratigraphic features
across the holes, assuming that the stratigraphy is a perfect “layer cake” across the holes.
Even in cases where that assumption is true, in general not all stratigraphic features in two
cores can be perfectly aligned because the cores are stretched and squeezed during the
coring process. The SCS has to decide in which part of the core to establish the best
alignment of features. As a rule of thumb, the alignment of features should be best where
the SCS plans to establish a splice tie point, i.e., in the upper and lower parts of core
intervals that will be used in the splice.

The affine table resulting from the shifting process is a list of all cores from the participating
holes, each with a cumulative offset (m) relative to the default core depth below seafloor
(CSF-A) depth scale, whereby:

CCSF_depth = CSF-A_depth + cumulative_offset

The cumulative offsets are usually positive (downhole direction), range from centimeters to
tens of meters, and generally increase with depth.

Table 2-1. Affine table example, shown in spreadsheet view to facilitate view of content. The file
must be in CSV text format for upload to the LIMS. Specifications for each column are given in
Appendix 1.

Site Hole | Core | Core | Depth Depth Cumulative Differential Growth Shift type | Data | Quality
type CSF-A CCSF- offset (m) offset (m) rate type comment
(m) A (m) used

U1391 A 1 H 0 0 0 ANCHOR

U1391 | A 2 H 4.1 5.05 0.95 0.95 1.232 TIE

U1391 A 3 H 13.6 15.64 2.04 1.09 1.15 TIE

U1391 A 4 H 23.1 25.68 2.58 0.54 1.112 TIE

U1391 A 5 H 32.6 35.63 3.03 0.45 1.093 TIE

U1391 A 6 H 42.1 45.01 2.91 -0.12 1.069 TIE
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U1391 | A 7 H 51.6 55.36 3.76 0.85 1.073 TIE

U139l | A 8 H 61.1 65.78 4.68 0.92 1.077 TIE

Four methods are used to define core offsets and the applicable method can optionally be
noted in the affine table (also see Table 2-2):

e ANCHOR - the top of one core from one of the participating holes is correlated to, or
interpreted as, the seafloor reference. This is in general the only core not shifted
relative to the CSF-A depth scale (zero offset).

e TIE - a core is shifted to align one or more stratigraphic features with those in a core
from an adjacent hole that has (in general) already been shifted and is now
considered the reference. If specific tie points are selected that link a specific
stratigraphic feature between the two cores, the tie points have by definition the
same CCSF-A depth. Any other stratigraphic feature may not have the exact same
CCSF depth in the two cores because of physical squeezing and stretching of cores
during drilling and recovery, or a stratigraphic architecture that is not a perfect
layer cake.

e APPEND - features cannot be correlated between cores, and a core is shifted by
appending the top of the cored interval to the bottom of the cored interval of the
previous core in the same hole, as if no gap or overlap existed at the CSF-A scale. The
appended core has the same cumulative offset as the previous core (zero differential
offset).

e SET - features in a core cannot be tied to those in a core from an adjacent hole. A
depth shift is applied based on some assumptions, most commonly the CCSF/CSF-A
growth rate of the previous core in the same hole. This method is recommended
over the APPEND option because it is more realistic, particularly in depth intervals
where cores are expanding significantly.

Table 2-2. Shift types

Shift type Shift method Comment

ANCHOR Tie to sez-'lfloor (typically top of core, but not Only one core per CCSF scale.

necessarily)
TIE Correlative tie Most common and desirable.

Same cumulative offset as previous core in same hole Used to be common, will rarely be applied compared
APPEND . .

(zero differential offset) the SET method.

. . Necessary if TIE is not possible; generally better option

SET Set any offset based on information such as growth rate than APPEND.

In addition to the shift type, users can optionally indicate the data types used and the
general quality of the depth shift for each core in the last two comment columns of the affine
table (Table 2-1). Note that comments cannot contain commas because of the use of the CSV
format, where commas are column delimiters. The SCORS Uploader will check and reject a
correlation file if more commas exist than expected.

Short cores may not have had correlation data acquired, and data from cores disturbed or
damaged by the drilling process may have been filtered during download with the SCORS
Downloader. Those cores will not “appear” in the correlation data set and therefore not be
used in the depth shifting process. Depending on the correlation tool used, they may not be
present in the affine table unless manually added before uploading to the LIMS using the
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SCORS Uploader (see below). Correlation specialists need to be aware that if cores are not
present in the affine upload file, they will not be included in the CCSF depth scale and
therefore be missing in data reports. The uploader will check for the presence of all cores,
and if one or more are missing, will prompt the user to add them to the affine table, or
ignore them and be responsible for the consequences.

Core shifting and the affine table should be complete before splicing begins. If cumulative
offsets of cores are adjusted after splice intervals for those cores have been defined, the
splice intervals need to be revisited to ensure that no unintended gaps or overlaps persist in
the splice.

Splicing

After the cores of adjacent holes have been shifted into a CCSF depth scale, the SCS define
intervals in the depth shifted cores that will constitute the splice for a site, representing the
most continuous section and most complete stratigraphic representation possible with the
recovered cores.

The splice tie-point concept (deprecated)

The traditional process of defining the splice consists of using splice tie points, essentially
tie lines that splice the bottoms of upper intervals with the tops of lower intervals at exactly
the same CCSF depth. That process results in a splice tie point table (STPT) (Table 2-3), as
published in many ODP and IODP Proceedings volumes. Although the STPT used to be the
standard expression of a splice, it turned out to be inadequate when splices were
discontinuous, i.e., all intervals could not be tied to one another because of coring gaps,
drilling disturbance or inadequate data records. When scientists attempted to integrate the
segments of a discontinuous splice (often referred to as “floating splices”) to create a
“complete but discontinuous splice” as the overall most useful stratigraphic framework for
a site, they had to “fake” interval boundaries as ties in the STPT. Even in a continuous splice,
the first and last interval could not be adequately defined in the STPT. This led to the
computational routines in the IODP database to return unexpected and unpredictable
results. Therefore, in the current implementation of SCORS, users can optionally upload
their STPT files, but they are not used by the database internal computations.

Table 2-3. Example format of a splice tie-point table.

s o 3l
> (o} =z > O
- 2 w | 2
<Z) c c o <Z) cl ¢
o 9o D < < o 9 D < W
e | 5| 5| §| §| ¢ i g | = e |3 588 ¢ i 7
3 2| 8] & & o) 3 o E & 2 8 & & & 3 o
ul446 C 1 H 6 49 7.5 7.5 TIE Ul1446 Al 2| H| 3| 555 7.855 7.5
U1446 A 2 H 7 19.8 13.298 12.944 TIE U1446 C|2|H| 4| 214 12.444 12.944
uUl1446 C 2 H 7 35.9 16.919 17.419 TIE U1446 A| 3| H| 2| 136.1 16.661 17.419
ul44e A 3 H 6 111.9 22.419 23.177 TIE ul44e C| 3| H| 4| 545 22.385 23.177
ul446 C 3 H 6 84.4 25.594 26.387 TIE Ul446 Al 4| H| 2| 66.5 25.465 26.387
U1446 A 4 H 6 9.3 30.893 31.815 TIE U1446 C| 4] H| 3| 258 30.118 31.815
uUl1446 C 4 H 7 44.8 36.158 37.855 TIE U1446 Al 5| H| 3| 68.6 36.416 37.855
ul44e A 5 H 7 21.7 41.787 43.226 TIE ul44e C|5|H| 4] 28 41.15 43.226
ul446 C 5 H 7 14.5 45.545 47.621 TIE U1446 Al 6| H| 2| 93.2 44.682 47.621
ul446 A 6 H 5 333 47.513 50.452 TIE Ul446 C|6|H| 1| 1413 47.313 50.452
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The splice interval concept
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A more generic definition of a splice as a collection of splice intervals rather than tie points

eliminates the restrictions of a STPT. Splice intervals are defined by the core (from a site
and hole) that contains the interval, and the CCSF depths of the top and bottom boundary.

This process results in the splice interval table (SIT) (example in Table 2-4; specifications in

Appendix 2). Each splice interval is from one core only, however, more than one splice
interval can theoretically be defined from the same core. The SIT has replaced the STPT as

the correlation specialist’s main deliverable, along with the affine table.

The SIT format also includes the section and offset for top and bottom boundaries, because

those ultimately matter when investigators take sub-samples from the cores along the
splice. We learned the hard way that a third application may not always compute section
and offset correctly and therefore created the SCORS-QA applications to rectify that
potential problem (see section 4).

Table 2-4. Splice interval table file example, given in spreadsheet view to facilitate view of

content. The file must be in CSV format for upload to LIMS. Specifications for each column are

given in Appendix 3.
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U1391 | A 1 H 1 0 0 0 2 56.88 2.07 2.07 | CORE-
TIE

U1391 | B 1 H 1 127.5 1.28 207 | 4 54.8 5.06 5.85 | TIE-TIE
U1391 | A 2 H 1 79.73 4.9 585 | 6 83.21 12.43 13.38 | TIE-TIE
U1391 | B 2 H 2 6.73 11.07 13.38 | 5 11.37 15.61 17.92 | TIE-TIE
U1391 | A 3 H |2 77.82 15.88 17.92 | 7 46.44 22.87 2491 | TIE-TIE
U1391 | B 3 H 3 61.44 22.61 2491 | 6 122.5 27.73 30.03 | TIE-TIE
U1391 | A 4 H |3 135.46 | 27.45 30.03 | 5 147.81 | 30.58 33.16 | TIE-TIE
U1391 | B 4 H 2 16.77 30.17 33.16 | 7 22.14 37.58 40.57 | TIE-TIE
U1391 | A 5 H |4 43.77 37.54 4057 | 6 81.45 40.91 43,94 | TIE-TIE
U1391 | B 5 H 2 91.7 40.42 4394 | 3 145.86 | 42.46 45,98 | TIE-TIE
U1391 | A 6 H 1 97.37 43.07 4598 | 6 123.27 | 50.88 53.79 | TIE-TIE
U1391 | B 6 H 3 70.4 51.2 53.79 | 6 55.03 55.45 58.04 | TIE-TIE

Top and bottom of a splice interval can be determined in three ways:

TIE - A correlative stratigraphic features in two cores from two different holes

occurs at the same CCSF depths in both cores and is selected as a tie point (most
common and preferred method);

CORE - Tops and/or bottoms of cores are used to define the splice interval because
ties do not exist. This is a typical scenario when the core was shifted using the
ANCHOR, APPEND or SET method.

TRUNC - In the absence of ties, parts of cores may be truncated (omitted from the

splice interval) based on additional information such as drilling disturbance. This is
a possible scenario when the core was shifted using the SET, APPEND, or rarely the

ANCHOR method.
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» Note: truncation is implicit if data from a disturbed core interval were culled
during correlation data download (see “Download correlation data”), i.e., the SCS
will not “see” that disturbed interval in the data.

This results in nine top-bottom combinations, or Splice interval types (Table 2-5), which can
optionally be denoted in the SIT.

Table 2-5. Splice interval types.

Splice interval type Top Bottom Comment :;\k::‘:;:;i
TIE-TIE Correlative tie Correlative tie Most common case
TIE-CORE Correlative tie Core bottom Typical last interval TIE
TIE-TRUNC Correlative tie Truncation Rare
CORE-TIE Core top Correlative tie Typical floating interval
CORE-CORE Core top Core bottom Less typical floating int. 2':5:,\?;’%1_
CORE-TRUNC Core top Truncation Rare
TRUNC-TIE Truncation Correlative tie Rare

. SET, APPEND,

TRUNC-CORE Truncation Core bottom Rare ANCHOR
TRUNC-TRUNC Truncation Truncation Rare

3. Software installation

Correlator is available from the Corewall web site, however, the JRSO cannot guarantee that
the latest version a user may find at that site is the latest one we are using on the JR (and
that is described here). The most recent changes implemented through a contract between
the JRSO and UMN (currently CorrelatorMac_2.1_rc2) will always be available here:

¢ Find the Correlator application on the following JRSO web sites:
» Ship: (Don’t try this on shore....!) http://web.ship.iodp.tamu.edu/apps
» Shore production: http://web.iodp.tamu.edu/apps/
» Shore test: (only available to IODP staff) http://short.iodp.tamu.edu/apps/

e Follow your browser and operating system’s instructions to install and launch the

application.
Correlator installs a directory for its internal database at a default location that looks
something like this:
Documents [or other system folder]
Correlator
2.1 [or similar version number]
db
default.cfg
log
temp

When user imports correlation data from a directory of choice, Correlator indexes the data
and places them in this directory for internal use. User doesn’t have to be aware of this
directory but can find the path at:

e File>Data Repository Path
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4. Basic functions of Correlator

Correlator operates within a single window that can be toggled between the Data Manager
view and the Display view (Fig. 4-1). To navigate between these views, use the top button
on the floating toolbar, or use the View menu. The tool bar is always available unless turned
off in the Preferences tab to the right of the window. The entire application window can be
expanded as much as available monitor space permits.

Figure 4-1. The two main views in the Correlator main window.
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The Data Manager view has three functional tabs across the top:
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o The Data List tab lists the files imported into Correlator and provides the main
functions for managing the data in Correlator. The data list items are organized in a
tree structure by site, data type, and hole.

o The Generic Data tab displays data from files being imported when such an import
is triggered in the Data List tab.

e The Data File tab function is to display any data set listed in the Data List tab.
The Display view has task tabs located vertically on the right side of the window, mostly
corresponding to buttons on the floating toolbar (Fig. 4-1B):

e (lose: Closes Tab Information window

e (Composite: Parameters and correlation plot for depth shifting.

e Splice Interval: Parameters and correlation plot to construct splices.

e Age Depth Model: not used/discussed here.

o Filter: Parameters for decimating, smoothing and/or culling data (creates Cull
Table)

e Preferences: Display preferences

The graphics part of the Display view is separated into the depth shift (composite) and the
splice sub-windows separated by a sliding middle bar. The bar can be dragged left or right
for more room on either side (Fig. 4-1B).

e The splice sub-window can be removed by unchecking the Splice/Log Window box
in the Preference tab.

Note that the selection of a particular tab does not constrain the actions user can take in the
graphics part of the window. This means that user may have the splice tab selected but be
depth shifting using the context menu.

|Good or bad? For now just an observation. |

5. Import and load correlation data

Import correlation data files

e Inthe Data Manager view, click the Data List tab. The list is empty when you start
out except for the Root item.

e You have to import each file separately for them to show up in the Data List.
» Right-click on the word Root on the top line item and select Add new data (the
only option except deleting Root).
» A browser window opens that allows user to browse to the data files in a
directory of choice.

0 Content of each data file must be for one hole and one data type. This is
automatically true if using LIMS data via SCORS Downloader and is a
reminder for those using other data sources.

0 Best practice is to have the data files stored in separate folders for each
site.

» Data opens in Generic Data tab (Fig. 5-1)



SCORS Correlator user guide 21 November 2016

Figure 5-1. Data import opens in Generic Data window, where user may have to fill in the Data
Type column by clicking on the header “Data Type” and selecting the appropriate item.

® @ Correlator 2.1_rc2
Natura!G.arr.lma Data List JECICUELG Data File
Susceptibility
Data  Rafiactance Site Hole Core CaoreType Saction TopOffset  BottomOffset  Depth Data ?

1 Bulk Density(GRA)  U1446 A 1 H 1 10 10 0.1 18.6938694
2 Pwave U1446 A 1 H 1 20 20 0.2 21.58

3 User define U1446 A 1 H 1 30 30 0.3 2418333333
4 353 U1446 A 1 H 1 40 40 0.4 2530717595
] 353 U1446 A 1 H 1 50 50 0.5 25.76384258
6 353 U1446 A 1 H 1 60 60 0.6 26.1132870<
7 353 U1446 A 1 H 1 70 70 0.7 27.5599537
8 353 U1446 A 1 H 1 B0 80 0.8 27.57351852
9 353 u1446 A 1 H 1 20 a0 0.9 27.94351852
10 353 U1446 A 1 H 1 100 100 1.0 2B.316527T6
1 353 U1446 A 1 H 1 110 110 1.1 29.50852776
12 353 U1446 A 1 H 1 120 120 1.2 2B.7262963
13 353 U1446 A 1 H 1) 130 130 1.3 28.66296296
14 353 U1446 A 1 H 1 140 140 1.4 25.38605835
15 353 U1446 A 1 H 2 10 10 1.6 31.0976694<
" aga 111448 A 1 u a an an 17 24 7899999%

Path : /U fblum/D s/l 1 f2.1/ Import Dismiss

Composite mode

o Select appropriate items for the data columns.

» Mainly, you need to confirm or set the header of the first column if it is empty.
Click on the header and select one of the listed data types.

» If a suitable data type is not available, create a data label using User define. (Fig. 2-
3).

0 In the case of User define, also click the Register box, which will add the
name to the choice list. (Fig. 5-2).

» For the occasional column that has data and a question mark in the header, user

typically needs to select Bottom Offset, or Depth.

Figure 5-2. Registering a data type not available in the Correlator choice list

Correlator 2.1_rc2

Data List  Generic Data  Data File

Data Type Exp Site Hole Core CoreType Saction TopOffset  BottomOffset  Depth Data ?

1 353 U1446 A 1 H 1 3.18 318 0.0318 36.8

2 353 U1446 A 1 H 1 4.18 4.18 0.0418 39

3 353 U1446 A 1 H 1 5.18 5.18 0.0518 42.2

4 353 U1446 A 1 H 1 6.18 6.18 0.06179999¢ 44.7

5 353 U1446 A it et - 7.18 0.0718 43

6 353 U1446 A Green| 8 8.18 0.0818 37

7 as53 U1446 A 8 9.18 0.09179999¢ 35.4

B 353 U1446 A Register oK Cancel 18 10.18 0.1018 9.4

] 353 U1446 A 11.18 0.1118 40.4

10 353 u1448 A 18 12.18 0.12179999¢ 38.1

1 353 U1446 A 18 13.18 0.1318 379

12 353 u1446 A 1 H 1 14.18 14.18 0.1418 a5

13 353 U1446 A 1 H 1 15.18 15.18 0.1518 34

14 353 U144 A 1 H 1 16.18 16.18 0.1618 35.2

15 353 U1446 A 1 H 1 17.18 17.18 0.1718 36.3

" aga 111448 A 1 u 1 CRT 1@ 18 n1a1n a7 e
Path : /L. fBlum/D 1ts/C l 2.1/ Import Dismiss
Composite mode

o (lick and the focus returns to the Data List tab where a data summary line is
added.
» You may have to click on a parent item to expand the list (e.g., triangle in front of
“Root” after importing the fist data file).
» The data are organized in a tree structure by site, data type, hole.

10
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» Other lines without data are added such as Downhole Log Data, Image Data, etc.,
which is related to the original concept of Correlator as part of the Corewall suite
(not relevant for JR operations).

o Keep right clicking in the Data List to add more data. See later for the other options
that have now appeared in the context menu.

e Correlator also needs detailed section information so it can compute splice intervals
correctly. Section files are automatically generated from LIMS with each Correlation
Downloader download (a new, 2016 feature). To load a section file, right-click on
Section Summary, then select Import Section Summary (Fig. 5-3).

ISSUE: Correlator currently only allows one section file to be
uploaded. That means user has to concatenate the section files
downloaded from LIMS for each hole (and simply name the resulting
file “sections” or something). Then user has to delete the existing
Section Summary before uploading the updated file.

A change request for Correlator to accept multiple section files is in
the works.

Figure 5-3. In addition to the stratigraphic data, Correlator needs a section summary file.

[ ] @ Correlator 2.1_rc2
CECIEE) Generic Data  Data File
Data Enable Decimate Min Max Updated Time By Whom File
B Enable 1 10.1 177.4 2016-10-03 12:23 blum 3
c Enable 1 127 172.6 2016-10-03 12:24 blum 3
Image Data
¥ NaturalGamma Continuous 1 7.61 64.1
A Enable 1 12.47 64.1 2016-10-03 12:17 blum 3
B Enable 1 19.01 56.71 2016-10-03 12:18 blum 35
c Enable 1 7.61 62.7 2016-10-03 12:19 blum 35
£ Import Section Summary...
Stratigraphy
¥ Susceptibility Continuous 1 -1.0 114,33
A Enable 1 10 114,33 2016-10-03 12:06 blum 35
B Enable 1 -1.0 91.67 2016-10-03 12:10 blum 35
c Enable 1 1.0 61.33 2016-10-03 12:10 blum 3z

Path : /Users/blum/Documents/Correlator/2.1/ Dismiss

Composite mode

Note that right clicking on highlighted Data List items brings up different context menus
with several options (Table 5-1).
e Make sure you select/highlight the item first, then right-click it to get the
appropriate context menu.

|This doesn’t seem very intuitive for many users. |

o The special data type items added to list, even if users don’t import the data (Age
Models, Downhole Log Data, Image Data, Stratigraphy), have their own import
context menus and are not used/described here within the context of JR operations.

Table 5-1. Data List context menu items.

Data group Hole-data

Menu item Function Root level Site level . .
items items

11
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Add new data Import data from directory YES YES YES
Load Load data for plotting in Display view. YES YES YES
View YES
Edit ? YES YES
Discrete ? YES
Enable Erjable Itoad ,i.e., enable plotting in VES
Display view.
Disable D!sable !.oad , i.e., disable plotting in VES VES
Display view.
Delete Remove from Correlator. YES YES YES YES
Import cull table YES
The specified file is re-imported and
Update the information in Correlator is YES YES YES
updated.
Mainly used to generate affine and
Export splice tables a CSV files that can be YES YES
uploaded to LIMS.

Load data for correlation

Whenever sufficient data have been imported to Correlator and are available in the Data
List, user needs to load them for display and correlation. Correlator is loading the data from
its own database, which resides in the directory shown from the file menu:

o File>Data Repository Path
To load data:

e Inthe Data List, select, then right-click on a line item and select Load.
» You can load an individual file, a set of files for a data type, or all files for a site.
» Make sure that the files you want to load are enabled. When saved, affine and
splice tables are enabled and will be applied to the loaded data.
» After loading the data, the Data Manager view turns into the Display view
where the data is plotted and correlation and splicing functions are available.

Update Correlator data
During the typical JR work flow, correlators download the correlation data from LIMS each
time the data from a new core are available. This process is facilitated in at least two ways:

e The Correlation Downloader application has features that allow the download to be
executed efficiently with pre-configured parameters and by appending core data to
the hole data file (see chapter 1).

o The Correlator application remembers the source directory for each data file name.

To update the Correlator internal database with these files:

o Select the highest practical item in the Data List, right click and select Update.
» No, you don’t have to delete the data and re-import!

e Select the item again and select Upload.
» Yes, you do need to load them again.
» Make sure you also load the affine and splice tables again, if applicable.

12
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6. Preferences

Before starting to work in the Display view it is worthwhile looking at the options in the
Preferences tab (equivalent to using |Go to Display Prefsl button; Fig. 6-1). The options are
largely self-explanatory and not described further at this time.

Figure 6-1. Display preference options.

orrelator 2.1_rc2
Leg: 353 Site: U1446 Hole: A
Natural Gamma, Range: 12.47:59.94 Depth units: m z

asojn

Splice/Log window B Toolbar window

o '
& Show Line % |
Show composite shift arows 8
@ |
Show log shift arrows
g
Displs 1=
isplay Range 5
@
All Holes = =
H
Variable minimum: g e
Variable maximum: 2q o
— Q
@
e S
= Apply g
= — : p
—_— Axis width: 2
]
_— : <
- : Ruler Depth Scale
—— =
—_— K]
—— : min: max: g
Tool Bar 0.0 20.0 Apply 2
Go to Data Manager §
Save Keyboard Tie Shift Depth Scale 2
s Connect to Corelyzer In meters g1 Apply .
Discrete Points E
Go to Composite Change Color Set =
Go to Splice %
Go to Filters g
" @
Go to Display Prefs @
Exit Correlator

7. Filter data

If you haven't filtered the data a the time of download, or you would like to apply more
filtering (masking) now to facilitate correlation:

o Select the Filter tab on the right or the button on the floating menu
(Fig. 7-1).
o Set Filter Range option: if you loaded multiple data types, you can define here which
ones the filter parameters shall apply to.
» It appears “All holes” is a misnomer and should read “All data types”.
» If multiple data types were loaded, select the one the parameters shall be applied
to.

e Decimate: to reduce excessively large data sets:
» Set the number to skip data points.
> Click the |Apply| button.

e Smooth: to reduce noise.
» In the Smooth window, leave Gaussian as the Type default
» Leave 9 for the Width default
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» Set Display to SmoothedOnly
» Click the button.

e  (Cull: getrid of outliers.
» If you want to cull, click the Use parameters Boolean, otherwise the m button
will do nothing.

[t is not clear why this Boolean is needed since user has to press the
Apply button to activate the filters anyway.

» Enter # cm from each core top if warranted.

Why only top of core? I thought it used to be possible to cull intervals
from section ends too. This should be easier now that a section
summary is loaded.

» Data value: Set low pass and high pass values as needed for the data type. Apply
to all cores or selected cores.
> Click the |Apply| button.

Figure 7-1. Filter options.

Carrelator 2.1_rc2
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8. Shift Cores

To shift cores, you may want to select the Composite tab of the Display view to see the

parameter sub-window. You can also get there using the |Go to Compositel button on the
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floating menu. If no data are displayed, switch to the Data Manager view and load a data
type (see earlier section).

Note that you can shift cores even if you have not selected the Composite tab.

Several shift parameters are given in the parameter panel to the right (Fig. 8-1).

o TIE Shift Options
» Choice list 1: cores that shall be shifted.
O This core only
O This core and all below: This only shifts the cores “below” that are in the
same hole, but not correlated cores from the other holes, thus invalidating
all previously set ties below!

A change request is in the works to provide a third TIE option that
shifts all correlated cores in all holes, sustaining all existing
correlations.

> Choice list 2: Shift method
0 To tie: shiftis to user-defined tie (most common).
0 To best correlation: user can let cross correlation function determine shift
amount.
0 By given amount (m): user can set shift depth interval.

> button: allows user to clear a tie that has been defined but not yet
applied.
> button: applies the shift as defined.
e SET dialog: |Set by growth rate or %| button.
» Opens dialog....

e Undo Options
» Previous offset: The latest shift applied can be undone.

|It would be helpful if multiple past shifts could be un-done.

» Offset of core above:
. |Save Affine Table| button.
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Figure 8-1. Composite tab parameters.

® @ Correlator 2.1_rc2
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For the shift options user can also access context menus by right clicking on the red and
green dot symbols (Fig. 8-1).

e Red dot options:
» Clear

e Green dot options:
» Adjust depth with this core only
» Adjust depth with this core and all below
» Undo to previous offset
» Undo to offset of core above
» Clear

To make a tie:

o Shift-left-click a characteristic reference point, creating a red dot (reference point).
This core will not shift.

o Shift-left-click a matching point on the data from a different hole, creating a green
dot. This core will shift. A copy of the data trace from the core with the green dot is
overlain on the plot with the red dot.

o To move the floating trace over the reference trace for optimum correlation, drag
the green line/dot up or down; alternatively toggle the line with the arrow keys.

e Click the [Apply shiff button.

» The core that had the green dot is moved relative to the red point (anchor) and
changed to green (CCSF) to indicate the data has been depth adjusted. (Color cues
for tracking depth scale changes can be changed in Preferences.)

» The amount of shift (m) is shown on the plot.

e To delete the last tie before it is applied, click the button.

e To delete all ties and start over:
» Select Clear all ties from the File menu; or
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|Go to Data Managerl, open the Saved Tables tree, and delete the affine and splice

tables using right-click context menu.

» NOTE: Deleting the affine table will also remove your loaded data (rather than
just undo the shifts) and you will have to load them again. After re-loading, you
need to reset the Cull filters (the Smooth filter sticks).

To save the depth shifts, do one of the following, which will save the affine and
splice tables internally to Correlator:

> Click the [Save Affine Table| button on the Composite tab

» Click Save on the Tool Bar

» Switch to the Data Manager, which prompts you to save.

9. Construct the splice

For users of older versions of Correlator, note that the entire splicing functionality has been
redone in 2015-2016 to (1) comply with the splice interval (as opposed to splice tie)
concept, and (2) to use detailed section information imported along with the data types so
top and bottom of splice intervals can be properly calculated. Splicing is now easier and
more accurate and precise.

To create a splice:

Choose the Splice Interval tab in Display view, or use the button on the

floating menu.
» This will show the parameter sub-window for splicing on the right (Fig. 9-1).

Drag core data traces from the depth shift sub-window on the left to the splice
window on the right side of the divider.

Click on a core trace to make the splice interval top and bottom lines appear with

handle dots and drag or toggle them to the desired splice interval boundary depths.

» The resulting splice interval table in the parameter window to the right shows
the exact depth.

[Oct 2016 discussion] Dragging the core data traces over to the splice
window seems redundant. Why not allow splice interval definition in
the depth shift window and then display the resulting splice in the
splice window?

[Oct 2016 request] Users would like the option of displaying section
boundaries as this (a) helps identify core disturbance effects
associated with section boundaries, and (b) helps users avoid setting
splice interval boundaries very near section boundaries.

As aresult of completing issue CO01 from September 2015,
Correlator now has the precise information needed to draw section
boundaries.
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Figure 9-1. Display view with Splice Interval tab selected.
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Features in the parameter panel to the right (Fig. 9-1):

e A short form of the splice interval table, updated in real time as user defines
intervals:
» Core: a combination of hole ID and core number.
» Top (m): interval top CCSF depth of the interval based on current affine.
» Bot (m): interval bottom CCSF depth of the interval based on current affine.

[Oct 2016 discussion] Having the short form of the splice interval
table displayed in the parameter window is great; however, why not
display the full SIT (as specified for export), as well as the affine table,
preferentially as a floating window? Those tables are currently
viewable as CSV text files (not as nice as in columnar form) by going
to the Data Manager and using ~5 click actions.

e Interval Comments box: user can add a comment about the interval selection for the
interval selected in the table - the comment will be exported with the splice interval
table.

o Delete Interval @#| button: removes the interval selected in the table.

o Tie Options: If two cores dragged into the splice area overlap (say A2 and B2), one or
two of the following buttons become enabled:

» Top: Split A2 & B2|toggles with [Tie A2 & B2|, with the notation on the splice

interval top changing accordingly between Tie: A2 & B2 and B2 Top, respectively.
» Bottom: No Action if bottom of B2 interval dos not overlap with another core
data trace, otherwise it works the same as Top.

[Oct 2016 discussion] It is not immediately clear what the buttons are
trying to accomplish for the user; apparently, the buttons simply
change the nomenclature for the same thing, namely a splice interval
boundary. Perhaps this feature is a “left-over” related to the change
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from splice tie point table (STPT) concept to the splice interval table
(SIT) concept, and the way Correlator is now accounting for ties and
intervals.

. |Select Alternate Splice| button opens a dialog where user can select one of multiple
splices if multiple splices were previously created:
» CAUTION: “alternate” splice does not mean that this is a “secondary splice” that
only uses intervals NOT used in the “primary” splice! It’s just another splice.
» Data Type: User can select the data type for which to display the splice.
» Splice: user can select one among multiple splices.

. button brings up a dialog with the following options:
> If you do this, you will see in the Data Manager window that the
previous splice is automatically disabled.
> |Update Existing|is the typical choice.
» |Cancel

Changing the affine during the splicing process

While on the Splice Interval tab, the depth shift display area on the left is still active and
lets user define a shift using.

o [fuser clicks the button, a warning dialog appears:

» “Warning: This affine shift affects cores included in the current splice. These
cores will be removed from the splice. Do you want to continue?” (No, Yes). (Fig.
9-1).

» If user chooses “Yes”, the affected cores are removed from the splice sub-window.

0 User then simply has to drag the affected core trace(s) back into the splice
area and again define the top and bottom of the adjusted splice interval.

» If user chooses “No” and then cancels the shift TIE (e.g., via context menu),
nothing changes.

o [fuser has at some point created an alternate splice, the cores with compromised
splice interval boundaries are not removed from that splice. Only if and when user
switches to that alternate splice using the |Alternate Splicel button will they find a
surprise:

» “Error: Core B2: Applied affine shift (9.243) does not match shift in Splice Table
(7.918), can’t load splice.”

e In any case, user should make sure the depth shifting is complete before spending
the time selecting splice interval boundaries.

[Oct 2016 discussion] These problems could arguably be avoided if
depth shifting and splicing were fully integrated in terms of
accounting and graphics. Any core could be shifted at any time and
any splice interval boundary could be defined at any time, and the
resulting splice would be shown in the splice window in real time.
Given the propose accounting of core correlations and the proposed
“Shift all cores below in all holes” feature, splice interval boundaries
could be shifted with the cores. Any core shift and any splice interval
boundary shift would trigger an update in both affine and splice
interval tables as well as the plots. At any time, what user sees is what
user gets.
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To delete a splice:
e Go to the Data Manager
e Right-click on the line item
o Select Delete.

e After user acknowledges the warning, the splice is deleted and all loaded data are
cleared from the Display view. User has to re-load the data.

10. Export Data

You can export any data item listed in the Data List window of the Data Manager. When
working with the LIMS database, user will typically only be exporting affine tables and
splice interval tables, which will be uploaded to LIMS so any LIMS user can download any
LIMS data type by splice, including those not used in the correlation process. However, if
users work outside of the LIMS infrastructure, exporting splice data becomes important.

To export depth shifted and spliced data from Correlator (i.e., LIMS not available):
e Select a data item to be exported, right-click on it and select Export (Fig. 10-1).

e Under some circumstances you will get a prompt notifying you that data will be
cleared (Fig. 10-2).

This should be an option so user can continue work in Correlator
even if they export the data.

e Ifyou proceed with Export, you get a check box list of what should be applied to the
exported data (Fig. 10-3). Make your selection and export.

Figure 10-1. Export in data item context menu.
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Figure 10-2. Export prompt/warning.

21 November 2016
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Figure 10-3. Export options.
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When a LIMS user on the JR is done with shifting and splicing for a site, they want to export
the affine and splice tables and upload them to the LIMS where CCSF depth scales and splice
intervals are generated. Any authorized LIMS user can then download depth-shifted and
spliced data from the LIMS, including data not used in the correlation process.

Select each affine/splice file item to be exported, right-click and select Export.
» If multiple affine or splice tables exist, the latest one will show as Enable
(enabled) and earlier versions as Disable (disabled).

» You can export either status.

» The status matters for loading and working with an existing affine.
» You can change the status of tables via the context menu.

Columns of tables exported from Correlator 2.1_rc2 are compliant with LIMS
specification for all practical purposes (see Appendix 1 and Appendix 2). The exact
column header spelling in the specifications is given to the right of the Correlator

spelling.
0 Affine table:

Correlator 2.1_rc2Site
Site
Hole
Core
Core Type
Depth CSF (m)
Depth CCSF (m)
Cumulative Offset (m)
Differential Offset (m)

LIMS

Site

Hole

Core

Core type

Core top depth CSF-A (m)
Core top depth CCSF (m)
Cumulative offset (m)
Differential offset (m)
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Other:

Growth Rate
Shift Type
Data Used
Quality Comment

0 Splice interval table:
Correlator 2.1_rc2Site
Site
Hole
Core
Core Type
Top Section
Top Offset
Top Depth CSF-A
Top Depth CCSF-A
Bottom Section
Bottom Offset
Bottom Depth CSF-A
Bottom Depth CCSF-A
Splice Type
Data Used
Comment

21 November 2016

Growth rate
Shift type

Data type used
Quality comment

LIMS

Site

Hole

Core

Core type

Top section

Top offset (cm)

Top depth CSF-A (m)
Top depth CCSF (m)
Bottom section

Bottom offset (cm)
Bottom depth CSF-A (m)
Bottom depth CCSF (m)
Splice type

Data used

Quality comment

Under certain circumstances export attempts fail and no error
message is given. [Describe in more detail.]
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Appendix 1: Specifications for affine tables

21 November 2016

Column header Uplf)ad file LIMS re‘port Format Examples Comments
requirements sourcing
. . from upload textupto 5 69, 987, 1103,
Site required file chars U1423
Hole required :irlzm upload single letter A B,C, ...
Core required f7°m upload |r1t§ger, 13 3,45,138
file digits
Core type optional from LIMS single letter H, X, R, ...
Core top depth CSF-A (m) optional from LIMS number 2.3,124.175,
1504.4
2.3,124.175
Core top depth CCSF (m) optional from LIMS number ! !
1504.4
Cumulative offset (m) required I;Zm upload number -0.56, 48.392
Differential offset (m) optional Elo'\r/lnsputed n number 0.012, 4.562
Growth rate optional Elol\TSPUted n number 0.91,1.05,1.21
Shift type F)pt|onal . from upload text up to 50 TIE, truncated Commas not allowed
information file chars
ional f I
Data used f)ptlona . T°m upload text up to 50 magnetic susc. Commas not allowed
information file chars
Quality comment .optlonal . from upload text up to 50 Tentative Commas not allowed
information file chars
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Appendix 2: Specifications for splice interval tables

21 November 2016

Column header Upload file LIMS report Format Examples Comments
requirements sourcing
Site required from upload file text up to 5 chars 69, 987, 1103,
U1423
Hole required from upload file single letter A B,C, ...
Core required from upload file integer, 1-3 digits 3,45, 138
Core type required from upload file single letter H, X, R,
Top section required from upload file integer 1-2 digits, 1,12,CC
or"CC"
Top offset (cm) required from upload file number 1.2,45,151.7
Top depth CSF-A (m) required computed in LIMS number 2.3,124.175,
1504.4
Top depth CCSF (m) required computed in LIMS number 2.3,124.175,
1504.4
Bottom section required from upload file integer 1-2 digits, 1,12,CC
or"CC"
Bottom offset (cm) required from upload file number 1.2,45,151.7
Bottom depth CSF-A required computed in LIMS number 2.3,124.175,
(m) 1504.4
Bottom depth CCSF required computed in LIMS number 2.3,124.175,
(m) 1504.4
Splice type optional from upload file text up to 50 chars | TIE, truncated Commas not allowed
information
Data used optional from upload file text up to 50 chars | magnetic susc. Commas not allowed
information
Quality comment optional from upload file text up to 50 chars | Tentative Commas not allowed
information
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